2009

Design communication through model making: A taxonomy of physical models in interior design education

Elaine Steffanny
Iowa State University

Follow this and additional works at: https://lib.dr.iastate.edu/etd
Part of the Art and Design Commons

Recommended Citation
Steffanny, Elaine, "Design communication through model making: A taxonomy of physical models in interior design education" (2009). Graduate Theses and Dissertations. 10733.
https://lib.dr.iastate.edu/etd/10733

This Thesis is brought to you for free and open access by the Iowa State University Capstones, Theses and Dissertations at Iowa State University Digital Repository. It has been accepted for inclusion in Graduate Theses and Dissertations by an authorized administrator of Iowa State University Digital Repository. For more information, please contact digirep@iastate.edu.
Design communication through model making: A taxonomy of physical models in
interior design education

By

Elaine Steffanny

A thesis submitted to the graduate faculty
in partial fulfillment of the requirements for the degree of
MASTER OF FINE ARTS

Major: Interior Design

Program of Study Committee:
Frederic C. Malven
Jihyun Song
Sunghyun Ryoo Kang

Iowa State University
Ames, Iowa
2009

Copyright © Elaine Steffanny, 2009. All rights reserved
DEDICATION

Special thanks to my dear God, committee members, teachers, family, and friends who kept me “alive” during my process in completing this thesis.

This thesis is dedicated to:

My lovely family who I miss so much everyday; my father, Steffie Tumilar, my mother Fentie Wisuseno, and my brother, Aldric Steffanny Tumilar.

My foster family, who always give me support, Mr. John Wood and Mrs. Ika Wood.

My teacher, who always inspires me, guides me and keeps me on track –

Professor Brenda Jones.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>ABSTRACT</strong></td>
<td>v</td>
</tr>
<tr>
<td></td>
<td>Chapter I. INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A. Rationale</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>B. Research Issue</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>C. Organization of Study</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Chapter II. LITERATURE REVIEW</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>A. Learning Tools</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>B. History and Types of Physical Models</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Chapter III. METHODS</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>A. Design Development: Learning Tool</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>B. Application of Learning Tool Design</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Chapter IV. DISCUSSION</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>A. Overreliance on the Computer</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>B. Negative Consequences of Overreliance on the Computer</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>C. Professional Benefits of Model Building</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>D. Educational Benefits of Model Building</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Chapter V. CONCLUSIONS</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>A. Summary</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>B. Recommendation</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>C. Future Study</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>D. Conclusion</td>
<td>89</td>
</tr>
</tbody>
</table>
ABSTRACT

To avoid misconception of design language use in a classroom/studio, a learning tool is needed to help create a uniform design vocabulary of class/studio materials given by an instructor to students in the teaching and learning environment.

There is one major issue to consider:

People in the interior design discipline are tend to misunderstand the real value of models, thinking of them primarily in terms of final design prototype or scale representations of the name.

This thesis will discuss three main components: 1) communication, 2) model making uses in interior design education, and 3) the invention of a learning tool. Communication is further divided into three parts: 1) general and public, 2) teaching and learning, and 3) interior design education.
CHAPTER I. INTRODUCTION

A. Rationale

The general background for this thesis study, other than my personal passion, is taken from the study of education in interior design, which has focused on communication methodologies. The term *manual/physical presentation* used in interior design study refers to an original manmade presentation or a presentation built by hand, using boards, hand-drawings and renderings, actual handcrafted 3D models, etc. Thinking of the deeper function of physical 3D models, these presentations are useful not only to demonstrate design ideas in a studio, but also to present various design subjects in other design environments. The goal of this thesis was to create a learning tool called Model Application Learning Tool (MALT), a media to communicate with interior designer (I.D), to work their creative minds, and to achieve a better understanding of the subject matter being taught. In this case, the subject matter is 3D physical models and their potential application to interior design (I.D).

Many aspects make physical models unique and effective as educational media in interior design. These different components in using selective representational media will be explored, resulting in a detailed taxonomy of physical model alternatives. The study also sought a set of basic principles for problem solving using models. Such a set of principles, the following steps were taken:

- Set up a system for a learning tool design, based on digital data collections.
- Determine a system or set of criteria for creating a learning tool.
- Define the learning tool’s components.
- Develop a prototype of the Model Application Learning Tool (MALT).
B. Research Issue

Educators sometimes underestimate the importance of choosing the specific method and/or instruments best suited to the communication of special topics to their student. Their own personal understanding of a full range of modeling options will help to ensure that their students select the most appropriate methods for communicating their ideas to clients. A major issue that will be answered in this research is: How would one describe the universe of physical modeling options?

C. Organization of Study

The organization of this thesis will be descriptive. The theoretical framework for this thesis is based on, but not limited to, interior design studies focusing on theories and principles about communication, education, and model making.

Regarding the type of design method and the assumptions that underlie this thesis, it builds the overall structure based on literature reviews, experiments, analysis processes, evaluation, and conclusion.
CHAPTER II. LITERATURE REVIEW

This chapter will cover the history and types of physical models and the learning tools that pertain to this research.

Sometimes educators unintentionally create particular problems in teaching, such as attempting to cover too much material, preparing lectures inadequately, and being disorganized and unclear about the learning subject in class and the expectations for students throughout the semester. Because of these unintended problems, students have difficulties in highlighting major ideas of the learning materials taught in class and show a lack of enthusiasm or interest for the subject. Improvement method is needed for not only lecturing skills of educators, but also presentation skills of students (this is especially beneficial for design students). Most educators lecture, and lecturing is essentially a form of public communication.

Certainly, even though students may achieve a degree through distance learning, students still must participate in classes while listening to professors’ lecture in class or on videos, or through on-line interactions with other students and the professors. Nowadays, perhaps another teaching method can be combined with the lecture method. Despite the growing technology and media available, many students have become bored and even confused by lectures. And, for some subject matter, the lecture is inadequate for communication of the desired content. Content related to physical models appears to be one such example. This learning tool builds systematically on various steps to ensure users can meet their goals concerning the nature and use of models while maintaining student interest. Ultimately MALT will make both teaching and learning more enjoyable and efficient.
A. Learning Tools

Students must be prepared for work in creative design production. Educators prepare them by utilizing a tool designed to support new approaches to teaching and learning in the classroom. The purpose of the learning tool is not only to investigate new ways to learn in a creative discipline, such as interior design, but also to support both educators and students in the education environment to use a mutual approach to teaching and learning practices.

Educators suggest setting critical ideas and emotional responses to meet changing educational and industry agendas. “New and creative work paradigms are now the norm in industries such as film and television, multimedia, music production, fashion and interior design. They require the capability to adapt. This collaborative approach to creative learning predicts new trends in understanding creative work practice in the contemporary world.” (Robertson, Molloy, & Versteegh, 2006, p.159-164)

In 1994, the term “learning object” became famous when Wayne Hodgins introduced it as a learning tool in learning architecture. Followed by Polsani in 2003, the concept of learning tool appeared more frequently in many discussions (p.19). In 2003, LTSC defined the learning tool as “any digital or non-digital entity that can be used, reused, or referenced during learning supported by technology.” (LTSC, 2000). Furthermore, Wiley defined the learning tool in narrower means, which is “any digital resource that can be reused as support for learning” (Wiley, 2000). Therefore, many researchers determined digital resources could be in the form of notes, pictures, and objects. Polsani (2003) put more into the discussion that the learning tool acts as a unit of learning, which should be reused in multiple instructional contexts. Polsani agreed that a digital format helps learning (p.19). According to Sicilia and Garcia, the learning tool acts as “digital units of independent didactic contents, which can be
used in multiple educational contexts, and which are associated to descriptions regarding how to use them in these contexts” (2004). A similar definition was also mentioned by L’Allier (1998). David Merrill defines a learning tool in a different means, as “a way to organize a data base (knowledge base) of content resources (text, audio, video, and graphics) so that a given instructional algorithm (predesigned instructional strategy) can be used to teach a variety of different contents” (2002).

Based on a compilation of various authors’ definitions, one can propose a single definition. The learning tool term is an informative digital media used through an active learning process in achieving important knowledge for users, where its interaction is flexible, adaptable, and reusable for personalized learning in different educational frameworks.

A learning tool, as an instrument to introduce taxonomy of models used in interior design education, is needed. This instructional tool should be comprehensive, easy to understand and to access, and flexible for data improvement at anytime during the study. It is designed with the approach of the modern creative work environment demand of today.

There is research about learning objects that act the same as learning tools. They have been mainly focuses on the follow characteristics:

1. “Conceptual frameworks” defines a learning object as having, main attributes or characteristics, taxonomies, and life cycle as components to be considered a multimedia material. (Agostinho et. al, 2004; Dolphin and Miller, 2002; Friesen, 2004, p.59-70; Hodgins, 2004; Ip et. al, 2001; McGee, 2003; Merrill, 2002; Murphy, 2004; Polsani, 2003, p.19; Semmens, 2004; Wagner, 2002; Wiley, 2000).

2. “Size” is a successful establishment of the learning object required reusability. Therefore, appropriate size of the learning object should be fit for sharing and reusing

3. “Description” identifies of the learning object needs to be clearly written. It usually is facilitated by providing descriptive data to the learning object. It needs to be consistent in describing the learning object’s characteristics. (Brown, 2002; Castro, 2002; Farrel et. al, 2004; Li et. al, 2005; Or-Bach, 2005, p.93-97; Recker and Walter, 2000; Saddik et al, 2000, p.87-94).

4. “Storage” combines learning objects as organized, managed, and accessed carefully. (Abernethy et. al., 2005; Dhraief et. al., 2004; Friesen, 2001, p.219-230; González, 2003; Hatala et. al., 2004; Neven and Duval, 2002; Soto et. al., 2006, p.223-227).

5. “Design” uses learning objects as guidelines or creative design tools to assist educators and students to produce educational environment through a systematic process. (Brady, Conlan, & Wade, 2005; Chalk et. al., 2003; Kotzinos, 2005, p.307-314; Smith R., 2004).

“Learning objects will need to be conceptualized, designed, constructed, selected and used quickly and easily” (Hodgins, 2004). Here, the term of learning “object” is the same as the learning tool. The idea of a learning tool is based on the possibility of students being able to adapt with multimedia resources to personalize their learning styles. That is why the learning tool should provide flexibility to allow students options to suit their specific needs, interests, and experiences. By adopting a learning tool, students supposedly learned new concepts and knowledge to be shared and representative for diverse situations.
Currently, it is necessary to develop a digital media. This media has a specific functionality, using technological media to improve personalized learning. Such digital media should be used more often in the educational environments where users are able to maintain digital learning material as their necessities, inspirations, and skills. One example is to create digital libraries which “are virtual collaboration spaces that provide means for acquiring, sharing and generating knowledge.” (Sánchez, 2004).

According to The American Heritage Science Dictionary, in 1828, word taxonomy is introduced by Linnaeus. Taxonomy comes from the word taxonomie in 1813, taxis and nomia. Taxis means arrangement or taxidermy and nomia comes from nomos which means method and managing or numismatics. So, taxonomy is known as the technique of systematic classification. It usually deals with description, identification, and classification of organisms, ordered in groups of a category, based on similarities of structure.

A database system provides a wide variety of extensible teaching resources. Meaning, it can be used for delivering lectures and building user interactivity between educator and students. This is accomplished by adding annotations or comments for the course material by the teacher in advance, and student can add their knowledge and match those comments (records students’ movement) as well. This interaction can be achieved by a database system because of the system’s ability to provide features to modify (add, update, erase, etc.) data, so that it gives users better control of the media element. This includes keeping data current and accurate. Computerized databases offer a many advantages, better than paper-based in speed, reliability, precision, and the ability to automate many repetitive tasks.

A database file is organized into one or more tables. Tables store records. Each record is a collection of fields and includes information (type, form, definition, example, and so on).
Each piece of information is stored in a separate field. For example, FileMaker Pro, the database that was used for final development of this project displays fields on layouts. Files created on a Mac platform can be opened in Windows, and vice versa.

The advantages of using the learning tool for students in their learning processes are as follow:

1. Personalized learning styles
2. Simple learning package
3. Easy access almost at anytime

The advantages of using the learning tool for educators in their teaching process are as follow:

1. Efficient teaching resource
2. Adjustable resource for personalized presentation style
3. Reusable resource for long term use (data can be changed or improved)

**B. History and Types of Physical Models**

B.1. History and General Issues of Models

Models have been made and enjoyed for centuries as representational objects. Models, miniature replicas, seem to be part of human nature, since the earliest archeological artifacts (for example, prehistoric figure objects found in the tombs of the pharaohs), which we can see in museums. Everyday objects and figures have also been miniaturized over the centuries to serve as toys for children. Dolls, dolls’ houses, and model soldiers are classic examples. Kings and generals, including Frederick the Great (1712-86), are said to have learned their first military lessons with the aid of toy soldiers (Payne, 1996, p.9).
Most of the technical development occurred during the industrial age for production processes. For example, the French inventor, Denis Papin (1647 – 1714), who pioneered the development of the steam engine, made all of his experiments by means of models (Payne, 1996, p.8).

During the 1930s, models with construction kits became popular. Most of them were made of cardboard, wood, or metal. Plastics use started in 1938, but became popular in about the mid-1950s. Since the early 1960s to the present, model making became popular even more for collections and hobbies to millions of people. Models with construction kits became more complex with motorized and radio-controlled apparatuses included as part of the models (Payne, 1996, p.10).

Modern computer simulation has not completely replaced the need for models. Models found these days are more popular when they look more realistic. They continue to be used as instruments for (not limited to) hobbies to make decorative miniature or toys; instruments for commercial or marketing displays; instruments for applying ideas, experiment with information and project developments; instruments for applying two-dimensional drawings into three-dimensional objects as a better visualization of a design project; instruments for research; instruments for product design as prototypes and to sell; instruments for instructional object; instrument for object demonstration and discussion; and instrument for presentation and teaching in business, art, engineering, chemistry, military, industrial, electrical or any other education disciplines (Payne, 1996, p.8).

During this research, it has been found that usually model makers like to build prototypes as precise and as realistic as they can. Other model makers like to imagine discovering a subject themselves (Payne, 1996, p.10).
The ability to make models shows that the model builder can work to the maximum of his/her intelligence and imagination. In architecture and interior design education, students must learn about how to build models from drawings and to treat models as a delicate design development, which depict the structures and spatial relationships, and details are shown and examined in the sculptured form. They not only document their process in building their models, but also document their finished work as a successful conclusion to a project with professional photographic documentation for portfolios and/or displays. People learn about the arrangement of units’ function, joined construction, and relationships with one aspect to another of the design elements and needs of the space. This is related to the goals of the designer - problem solving is the most important goal of all. And building a model is a way to develop the process in seeking and experimenting with the problem’s solution given from the space (Knoll & Hechinger, 1992, p.6).

There is a stage where people should have an idea of how the finished model will look. Thus, the steps that people should complete before they start building their models are decide what kind of model and the subject they are going to build for their model. Next, research the subject and the materials needed, then prepare some sketches and drawings. Finally, start to build some study models before building the final model (Payne, 1996, p.13).

A drawing has the ability to be modified instantly and spontaneously. But, a drawing only deals with lines as a graphic element, which lack volumetric sense because of the flatness and abstractness of the quality (Knoll & Hechinger, 1992, p.7). It is difficult to visualize the space in the limited number of drawings that one can produce. Even though a model does not have the ability to be modified instantly and spontaneously once it is finished, a model has the ability to transform immediately of the ideas of the concept, spatial
issues, and materiality, because of its volumetric quality. An option given here is, instead of producing many drawings to achieve the best understanding of the space, one can use the effort to build one finish model that shows the best understanding of the space. Especially, in architecture and interior design reality, people will use the design to build a three-dimensional form from it. By building the physical model of the proposed design, it becomes the nearest visible media that people can use, see, and understand for the proposed solution made by its designers.

In deciding materials to use for building models, one must consider materials that suit the speed for the scheduled time, easy to modify as desired, and able to hold the shape for the require scale (Mills, 2005, p.7).

It is often said, “the best way of doing something is the way that works for the particular individual” (Payne, 1996, p.13). In building models, it must be clear about the materials and assemblies to make them fit well together as a whole. This is also the case when some finishes the models. For example, when the model needs to be painted to achieve a finished look, it is better to paint it during construction because some parts will not be easily painted when everything is already glued together as one piece. In the case of large and sophisticated models, it is wise to think in terms of a series of sub-assemblies, and give a clear consideration to how they will fit together (Payne, 1996, p.14).

Some people build their models with some operation system included in the models. Some models provide movement or even lights. When models incorporate these elements, the builder should consider how the model will be powered. The builder should think about how to expose or hide, and how the model will be maintained (Payne, 1996, p.14). Here is an example of studio works that can stimulate thinking in finding operational ideas for models:
“Function Analog” assists many inventions that occur as a result of analyzing the way something works. The studio action is “analyze the way something from industry or nature works. Design and art from which analogizes or mimics that function” (Roukes, 1988, p.24). This specific activity is about “learning by doing.” Seeing the operation of a mechanical object might build interest to see how the object operates. When the operational technique has been studied, then one can use the system analogy for something else; for example, a computer keyboard operation is analogous with the keypad operation on a cell phone. As we become aware of similar operations from one object to another in the things that we use in life, we can also use a similar operation in a work of art (for example, creating an art work which has an element that moves by the analog operation of a clock’s hand). So, new inventions come about as a result of analyzing the way something works. To create the future, we need to understand the past.

When building any kind of physical model, people are required to have some basic tools. The tools do not have to be expensive; even though some people may like to purchase some cool electronic technology such as an expensive laser cutter that costs thousands of dollars to make the model building process super easy. However, it is not necessary. People can survive with basic tools like pencil and eraser, artist brushes, glue, stapler, pins, paper, board, wood, metal, ruler, t-square, craft knife, coping saw, pliers, sandpaper, small hammer, cutting matt and maybe drills. And then, in the process of building the model, people must always make sure that safety for themselves and for others is the number one rule (Payne, 1996, p.18).

The next consideration to think of is how to transport your model, easily and safely, to where the model will be displayed and how to display it. For public display, usually
models are placed at about four to five feet height or at around natural eye level. However, in many cases, considerations should be made for children and wheel-chair users in a public exhibition. Lighting is another issue. For either private or public display, adequate lighting is needed. Especially, when the model builder already has a plan about how the model should be lit, it will be useful if he/she applies the model’s finishes under the same lighting effect that will be used for display. This will reflect the results more accurately in how people will see the model the same way the model builder intended (Payne, 1996, p.15).

Since the model is a replica of something else, it needs to have a specific scale to be built. This depends upon the purpose of the model, space, time, and budget. An accurate scale must be precise to achieve the best output (Payne, 1996, p.26). The model should consider shape, function, and construction. The shape includes treatments of form, size, light, direction, materials, and color that hold in the model’s structure to make it aesthetically appealing. This function includes arrangement of interior and exterior structures that utilize the model. And, the construction includes scale, proportion, joins, and detail of the model (Knoll & Hechinger, 1992, p.7).

B.2. Types of Architecture and Interior Design Models

Briefly, the types of study models are divided into two components. They are primary models and secondary models. In interior design study, primary models are abstract models which focus on design exploration. They usually are concerned with design evolution. Primary models include sketch, diagram, concept, massing, solid void, development, and presentation. On the other hand, secondary models are specific component models and focus
on the structure of the building designed. Secondary models may include site, exterior, interior, section, framing/structure, and detail/connections (Mills, 2005, p.11).

“Study” models have the purpose of generating and investigating design ideas, which means they have the possibility for refinement. They can range from quick and rough constructions to a really fine construction with serious attention to craft.

“Sketch” models usually build on relatively small scales and are made of inexpensive materials. They act like hand sketches/drawings exercises which have the features of spontaneity and flexibility. They should be easy to modify during the exploration process which has a variety of design directions still. So, it is not so important to give serious attention to craft as long as it provides a fair quality in readability of visualization of the spatial relationships, circulation, proportion and other design components that appropriate to be addressed (Mills, 2005, p.12).

“Diagram” models act as like 2D diagram sketches, which inform issues, such as circulation and site relationships. The quality is better than for the sketch model with further exploration in architectural issues (Mills, 2005, p.13).

“Concept” models are usually built for exploring concept ideas, including site relationships, materiality, lighting issues, and further architectural directions (Mills, 2005, p.14). It is a three-dimensional representation of a two-dimensional conceptual bubble diagram without a specific scale, but must relate to bubble diagrams in their proportioning and importance of the spaces. The model can be as abstract as circulation forms penetrating nodes and focal points, or as literal as corridors leading to rooms (Buckles, 1991, p.2). Porter and Neale (2000) defined conceptual models as three-dimensional diagrams fabricated when an idea is still fragile. They are usually constructed quickly and inventively, using found
materials or mixed media to symbolize. An example is a relationship between components of a building concept with the setting. These conceptual models are usually used at the initial working stage to test recently forming ideas. They represent an intimate, developing sketch in three dimensions (Porter & Neale, 2000, p.21)

“Massing” models are often quickly built for volumetric exploration, which focus on size and proportion. They are constructed in small scales, usually as site models, without attention to openings and details (Mills, 2005, p.15).

“Solid/void” models are built by applying the open and closed areas of the building to give certain character to them. Mills (2005) notes these models usually are developed and refined to present better visualization of the space because the openness can reflect how the building will be illuminated (p.16).

“Development” models involve some initial decisions for a further level of exploration with some attention to details, before proceeding to the final ones, such as wall and window treatments, roof configurations, refinement of forms, scale, proportions, etc. The size of these models is usually bigger than the other earlier study models and they still have flexibility for some modifications. However, the model needs to have the ability to show general building relationships, materiality, and other studies that are more refined (Mills, 2005, p.17). According to Porter and Neale (2000), design development models are among the most important and exciting of all model types (p.24).

The conceptual forerunners, from which they are generated, are constructed in an unselfconscious manner, their major aim being to try the feasibility of a challenging architectural form. Therefore, their often spontaneous appearance results from their need to explore the fundamental nature of an architectural concept often enlisted as an inventive use
of model making media (Porter and Neale, 2000, p.24). In building a work/development model, there are some criteria that should be reviewed. Models which use to investigate or experiment with internal shape, spatial relationships, and details in the developmental stages of design (or a nearly final stage) can be constructed using materials that are flexible, durable, and sometimes specific materials to achieve the desire visual and tactile effects on the model.

“Interior” models are built to study spatial relationships and other architectural elements, color, and furnishings. Interior models make processes in parts rather than the whole, which should suffice (Bayley, 1950, p.67). Mills (2005) notes models are built usually to a scale $\frac{1}{4}” = 1’0”,$ or $\frac{1}{2}”=1’0”$ or larger, depending on how much detail the elements in the model should depict. The internal space of the model should be accessible to view by allowing the rooftop or part of the wall to be removed, etc (p.22). Porter and Neale (2000) also have similar opinions about the interior models definition. They state that interior models are built to visualize and address spatial, functional, and optical questions, and are vehicles to document and demonstrate these functions to others. To provide these visual accesses, models at different scales are often constructed in ‘knock-down’ form so that roof planes, exterior wall planes or even complete stories can be removed. An interior model is seen as ‘sculptural’ assembly of actual samples of materials, construction connections and colors used in the interior space (Porter & Neale, 2000, p.30).

Knoll & Hechinger (1992) has another similar opinion for defining interior models. He states that interior models are representational of either single rooms or several rooms at a time, and have the job to visualize space and covering to answer functional and optical questions (p. 21). He also mentions models frequently show selected color, materials, and
furniture. Kurabayashi (1994) also eludes to similar explanation - interior models should show the use of forms, materials, and colors that are more true to the original which usually cannot be represented adequately with paper models (p.7). In a more extreme case, Janke (1978) states the purpose of interior models cannot be adequately checked on drawings to clarify the three-dimensional effect of design features (p.78).

Interior models, especially those prepared to study individual rooms or parts of a building, do not reproduce the exterior and usually omit the adjoining rooms. Interior models also may be defined as building models with designed interiors, where the interpenetration of the inside and the outside can be examined (Janke, 1978, p.80). Finally, according to Pattinson (1982), interior models can be built with or without regard for their exterior treatment. They are built to represent interior arrangements, facilities, and furnishings to obtain the best space use or interior decoration (p.7).

“Exhibition” models are built by or for the architect as an informative and analytical version of the presentation model. Their public exposure can function as a medium, which may result in the viewer visiting the construction site (Porter and Neale, 2000, p.36). Buckles (1991) notes the final presentation model is built at the end of design process when design development drawings are complete. The model generally has color, building material indications, and scale figures to simulate the actual proposed building as realistically as possible (p.8). According to Porter and Neale (2000), presentation models give evidence of immediate settings, for clear communication about its finality (complete and fully-detailed composition of an architectural solution) to others (p.36).

In professional practice, a presentation model represents a fixed state of the design to clients or the public more effectively than a set of drawings. In education for students,
presentation models present only the relationship of space, with little indication of materials or form of construction for an introductory architecture course (Eichbaum, 1975, p.16).

According to Pattinson (1982), presentation models are one of the least descriptive of terms, since any model can serve as a presentation medium. Members of a church parish, for example, would probably be presented with a display model with architectural detail and landscaping as an aid for fund-raising. The church’s building committee may have been presented with a study model of the project completed or detailed only to the extent necessary to show the architect’s concept of the requirements (Pattinson, 1982, p.5). In building an exhibition or a presentation model, which is understood as a final model, there are some criteria that should be reviewed. One can use materials that are stable, durable, and light for ease of transport.

The tools used in the process depend upon the needs of the model types with a high quality of performance. Because of the complexity of the work, space to work on this model may be special like a single room dedicated for a studio or a woodshop, etc. An exhibition or a presentation model usually includes other features for completion. They can be people figures, landscape, animals, cars, etc. as elements for a finishing touch. These elements are not only used as decorative elements, but also give a sense of scale and proportion of the model created (Knoll & Hechinger, 1992, p.19). Mills (2005) finds presentation/finished models have the purpose to represent complete design decisions with a high attention to craftsmanship. They have options, depending upon the purpose of the model, to include only monochromatic color or a complete color scheme. In architecture study, models for presentation purposes are built in a monochromatic scheme to avoid distraction (p.18). On
the other hand, in interior design study, non-colored models usually qualify as unfinished models. In this discipline, a finished model should be colored.

When exploring the performance and function of models in interior design discipline, models can be made with adjustable and flexible arrangement of interior furnishings. This alternative allows a different variety of visibility options and has the ability to make minor changes in the interior arrangement/position for viewers’ desires and experiences without building multiple models.

There are several other models used in architecture, landscape architecture, and (sometimes) in interior design. Miles (2005) notes “site contour” models are built to study site relationships, showing the rise and fall in the landscape to depict the control of fit/placement of the building and landscape design. A site model presents a topographic view, showing features of the site and the changes proposed by the new design, various built-up areas, traffic areas, green spaces and water surfaces are clearly indicated (Knoll & Hechinger, 1992, p.10-19). Site models are usually built at the outset of designing. They appear as dimensioned representations of the topographic setting for a proposed building design and record the nature of the site terrain and include evidence of site features that will have impact on the design, such as existing buildings, circulation routes, and planting (Porter and Neale, 2000, p.23).

The site model is built to study the relationship of the structure to the contours of the land, or to study orientation of the building in relation to other buildings in the surrounding area. An example is to study the effect climate may have on the sitting of a building (Eichbaum, 1975, p.15). A site model is usually limited to a small-scale model of an entire site of ownership, as opposed to a larger scale model of a portion of that site holding a single
element of improvement such as the administration building of a large complex. A site model shows an entire area of ownership. Pattinson (1982) notes contour models usually study changes in natural grade, which corrected to a finished grade before structural improvements can be built. They show open contours for study of the terrain (p.6).

“Site context/urban” models are built in a medium to large scale. This enables a study of the entire/general area, relationships of the surrounding buildings, the neighboring area, and landscape design. They are used like other study models to explore relationships, only on a much larger scale and usually depict all built elements as massing blocks. Urban models look at an entire urban condition from sectors of the city to an entire urban settlement (Mills, 2005, p.20). Urban models are made on the basis of topographic models. They can be used either as overall city plans or to represent more detailed sectional plans (Knoll & Hechinger, 1992, p.10-19).

“Entourage/site foliage” models are built to stimulate and give a sense of the building’s scale. These models are usually built in abstract, are simple, and include people, trees, and site furnishings (Mills, 2005, p.21).

Similar to “sections” drawings, “section” models are built to study relationships between vertical spaces by slicing the building at a certain angle to show interaction between vertical relationships in interior spaces (Mills, 2005, p.23). “Models in which longitudinal sections or cross sections of buildings are represented and have the advantage of illustrating not only the sectional plane itself, but also explaining the effect of the construction on the building’s spatial character. They provide information on the structural system revealed in the sectional plane in wall thickness, beam dimensions, floor strength, and clear headroom” (Janke, 1978, p.64). Section models are sometimes called stage set models when they are
concerned with a single vertical plane or façade as on a moving picture lot. They are used to serve in esthetic or a structural analysis of a portion of a building, a single façade, an entrance architectural screen, and a portion of a colonnade (Pattinson, 1982, p.7).

“Framing/structure” models are built to show the building construction regarding framing and structural systems in space. For instance, they show the exposed beams, trusses, and maybe other complex geometries, as well as special detailed connections and loading characteristics that makes the space hold together (Mills, 2005, p.25). Structural models show the structural design of a building without displaying the total external shape. They demonstrate the utilization and jointing techniques, but are usually employed to show the method of construction and it is often possible to find solutions to functional and assembly problems (Knoll & Hechinger, 1992, p.16). The performance of the materials used in structural models is a major factor in their selection. They show the way in which their appearance changes over time - how a building weathers is an important part of its character, whether it is part of a townscape or an isolated farmstead (Payne, 1996, p.30).

Structural models are often skeletal or avoid any display of the total external envelope in order to expose, test, and demonstrate structural, construction and service systems or their assembly. They function as three-dimensional physical working drawings (Porter and Neale, 2000, p.28). Structural models are those in which the structure of improvements is left open. They are built to view for the observer’s analysis or appreciation of a structural system. For example is the framing system of a private residence (Pattinson, 1982, p.7).

“Detail/connection” models are built to develop exterior and interior details such as construction joints/connections, operational detail systems, and interior treatments (window treatments, railings, and fascias). Detail models are built at much larger scales to allow a
finer viewing of the form’s articulation and connections. They are built usually with the scale $\frac{1}{2}'' = 1'0''$ to $3'' = 1'0''$, depending on the amount of detail the elements in the model should show (Mills, 2005, p.26). Decisions made on the basis of detailed models usually concern shape, material, surfaces, color and junctions.

Detailed item models are usually based upon accurate technical drawings and well-developed design concepts (especially for complicated single objects and series items that occur repeatedly) (Knoll & Hechinger, 1992, p.22). Usually, detailed models are of staircases, cladding, decorative elements, etc., or a section of a façade. The models thus become prototypes (Janke, 1978, p.64)
CHAPTER III. METHODS

This chapter will discuss design, development and use of the Model Application Learning Tool (MALT), and operational of its design. MALT will give students an easier method to learn and engage with each type of interior design scenario. The subject for this specific learning tool is taxonomy of physical models in interior design education. Therefore, the conceptual learning tool for the subject will be developed. MALT will be in the form of a database, constructed with Filemaker Pro, which carries taxonomy information about the physical models. And, the features contained within each learning tool’s parameters will be analyzed.

A. Design Development: Learning Tool

Model making is an important component of interior design education. For example, an interior designer will design a home. It is believed the only way to envision the visual thinking of the whole design idea to the clients is by building a model depicting its design. Therefore, an interior designer must have skills for model building. This starts with a physical or manual model to an advanced model, using digital modeling software such as CADD or Revit. Naturally, it is to how one learns three-dimensional drawing, which must pass first through learning two-dimensional drawing.

There is a method of classifying interior design models based on three main criteria—quality, subject, and form—as shown in Figure 1 and Figure 2.
As students study the history of interior design models, they will acquire an interest in the origins of the models, and therefore, learn more in-depth about each of the models.
Taxonomy is like a family tree. It carries a complete branch of accurate information about the roots and variety of interior design model making.

In an early stage of this study, first experimentation was completed to introduce the taxonomy of interior design models using a Microsoft excel spreadsheet. This did not work well because a large amount of information cannot be contained in the sheets and managed easily. Besides, the program lacks flexibility. One must continuously change or rearrange the date to achieve each display style needed. It was very confusing and was not well organized. Figure 3 gives an abbreviated example of what the data looked like in an Excel spreadsheet.

This spreadsheet shows simple information about each model type (in alphabetical order) mentioned by various authors.

Figure 3. An abbreviated example of data in an Excel spreadsheet

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Analog</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Animated</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Architectural Exteriors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Architectural History</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Architectural Interiors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Architectural Theory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Block</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Breakaway</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Building</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>City</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Conceptual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Construction</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Context</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Contour</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Decorative</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Figure 3 (continued)

<table>
<thead>
<tr>
<th>No</th>
<th>Types of Model</th>
<th>Authors</th>
<th>Knoll, W &amp; Hechinger</th>
<th>Buckles, M. G.</th>
<th>Kurabayashi, S.</th>
<th>Payne, C.</th>
<th>Mills, C. B</th>
<th>Smith, A. C</th>
<th>Bayley, T.</th>
<th>Janke, R.</th>
<th>Janke, J. T. and Neale, Porter</th>
<th>Eichbaum, N. T.</th>
<th>Pattinson, D. G.</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Design</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Design Studio</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Detailed items</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Development</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Diagram</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Engineering</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Entourage/Site Foliage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Equipment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Exhibition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Experimental</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Exterior</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Façade</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Figures and Animals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Full-sized Prototypes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Garden</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Industrial</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Interior</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Landscape</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Lighting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Map</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Massing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Mathematical</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Miniature</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Office Built</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Presentation</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Primary</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Product</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Qualitative</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>Relatively Subjective</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Reverse Scale</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Schematic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Secondary</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>Types of Model</td>
<td>Authors</td>
<td>M. Hechinger &amp; W. Knoll</td>
<td>M. G. Buckles</td>
<td>S. Kurabayashi</td>
<td>C. Payne</td>
<td>B. C. Mills</td>
<td>C. A. Smith</td>
<td>T. Bayley</td>
<td>J. T. and Neale, Porter</td>
<td>R. Janke</td>
<td>N. T. Eichbaum</td>
<td>D. G. Patinson</td>
</tr>
<tr>
<td>----</td>
<td>-------------------------</td>
<td>------------------------------</td>
<td>--------------------------</td>
<td>---------------</td>
<td>---------------</td>
<td>----------</td>
<td>-------------</td>
<td>-------------</td>
<td>-----------</td>
<td>--------------------------</td>
<td>----------</td>
<td>-----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>51</td>
<td>Section</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Site</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Sketch</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>Solid/Void</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>Space</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>Special</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Structural</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>Structures</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Student Presentation</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>Study</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>Topographic</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>Town-planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Urban</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>Vehicles and Machinery</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td>Wind Tunnel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In later stages, the final list of model types (Figure 4) in alphabetical order include:

| 1. Analog          | 22. Engineering     | 43. Primary       |
| 2. Animated        | 23. Entourage/Site Foliage | 44. Product      |
| 5. Architectural Interior | 26. Experimental     | 47. Reverse Scale |
| 10. City           | 31. Garden           | 52. Site         |
| 13. Context        | 34. Landscape        | 55. Special      |
| 15. Decorative     | 36. Map              | 57. Student Presentation |
| 16. Design         | 37. Massing          | 58. Study        |
| 17. Design Studio  | 38. Mathematical     | 59. Topographic  |
| 21. Display        | 42. Presentation     | 63. Wind Tunnel  |

Figure 4. Model types
Along with the above list, the taxonomy of models is established on similarity of characteristics, based on quality, form, and subject (build as slide presentation using Microsoft Power Point). These are seen in Table 1.

**Table 1. Taxonomy of models**

<table>
<thead>
<tr>
<th>1. Rough 3D Combination</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog</td>
<td></td>
</tr>
</tbody>
</table>

| 2. Rough Abstract Exterior |         |
| Diagram                   |         |

| 3. Preliminary 2D Surface Component |         |
| Conceptual                   |         |

| 4. Preliminary 3D Mass Exterior |         |
| Massing                       |         |
| Sketch                        |         |

| 5. Preliminary 3D Mass Site |         |
| Block                        |         |

| 6. Preliminary Abstract Component |         |
| Primary                        |         |

| 7. Preliminary Abstract Exterior |         |
| Conceptual                      |         |

| 8. Development 2D Surface Exterior |         |
| Schematic                       |         |

| 9. Development 3D Mass Component |         |
| Schematic                       |         |
| Structural                      |         |
| Study                           |         |

| 10. Development 3D Mass Exterior |         |
| Conceptual                      |         |
| Design                          |         |
| Design Studio                   |         |

| 11. Development 3D Mass Site |         |
| Contour                        |         |
| Contour                        |         |
| Endourage / Site Foliage       |         |
| Map                            |         |
| Planning                       |         |
| Site                           |         |
| Topographic                    |         |
| Town - Planning                |         |
| Utilities                      |         |

| 12. Development 3D Volume Exterior |         |
| Development                      |         |
| Solid / Void                     |         |

| 13. Development 3D Volume Interior |         |
| Interior                         |         |

| 14. Development Abstract Component |         |
| Lighting                          |         |

| 15. Secondary 3D Mass Component |         |
| Secondary                        |         |

| 16. Secondary 3D Mass Product |         |
| Architectural Interiors        |         |
Table 1. (continued)

<table>
<thead>
<tr>
<th>17. Experimental 3D Combination Component</th>
<th>21. Experimental 3D Mass Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architectural Theory</td>
<td>Structural</td>
</tr>
<tr>
<td>Section</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>18. Experimental 3D Combination Exterior</th>
<th>22. Experimental 3D Volume Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architectural History</td>
<td>Architectural Interiors</td>
</tr>
<tr>
<td>Building</td>
<td>Construction</td>
</tr>
<tr>
<td></td>
<td>Experimental</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>19. Experimental 3D Combination Interior</th>
<th>23. Experimental Abstract Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interior</td>
<td>Relatively Subjective</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>20. Experimental 3D Mass Component</th>
<th>24. Experimental Abstract Interior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structural</td>
<td>Space</td>
</tr>
<tr>
<td>Wind Tunnel</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>25. Presentation 2D Surface Component</th>
<th>29. Presentation 3D Combination Interior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering</td>
<td>Interior</td>
</tr>
<tr>
<td>Mathematical</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>26. Presentation 2D Surface Exterior</th>
<th>30. Presentation 3D Combination Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Façade</td>
<td>Animated</td>
</tr>
<tr>
<td></td>
<td>Display</td>
</tr>
<tr>
<td></td>
<td>Equipment</td>
</tr>
<tr>
<td></td>
<td>Exhibition</td>
</tr>
<tr>
<td></td>
<td>Full-sized Prototypes</td>
</tr>
<tr>
<td></td>
<td>Industrial</td>
</tr>
<tr>
<td></td>
<td>Miniature</td>
</tr>
<tr>
<td></td>
<td>Presentation</td>
</tr>
<tr>
<td></td>
<td>Product</td>
</tr>
<tr>
<td></td>
<td>Qualitative</td>
</tr>
<tr>
<td></td>
<td>Sales</td>
</tr>
<tr>
<td></td>
<td>Special</td>
</tr>
<tr>
<td></td>
<td>Structural</td>
</tr>
<tr>
<td></td>
<td>Student Presentation</td>
</tr>
<tr>
<td></td>
<td>Vehicles &amp; Machinery</td>
</tr>
<tr>
<td></td>
<td>Structural</td>
</tr>
<tr>
<td></td>
<td>Student Presentation</td>
</tr>
<tr>
<td></td>
<td>Vehicles &amp; Machinery</td>
</tr>
</tbody>
</table>

### Table 1.

#### 17. Experimental 3D Combination Component
- Architectural Theory
- Section

#### 18. Experimental 3D Combination Exterior
- Architectural History
- Building

#### 19. Experimental 3D Combination Interior
- Interior

#### 20. Experimental 3D Mass Component
- Structural
- Wind Tunnel

#### 21. Experimental 3D Mass Product
- Structural

#### 22. Experimental 3D Volume Component
- Architectural Interiors
- Construction
- Experimental

#### 23. Experimental Abstract Component
- Relatively Subjective

#### 24. Experimental Abstract Interior
- Space

#### 25. Presentation 2D Surface Component
- Engineering
- Mathematical

#### 26. Presentation 2D Surface Exterior
- Façade

#### 27. Presentation 3D Combination Component
- Breakaway
- Reverse Scale
- Section

#### 28. Presentation 3D Combination Exterior
- Architectural Exterior
- Exterior

#### 29. Presentation 3D Combination Interior
- Interior

#### 30. Presentation 3D Combination Product
- Animated
- Display
- Equipment
- Exhibition
- Full-sized Prototypes
- Industrial
- Miniature
- Presentation
- Product
- Qualitative
- Sales
- Special
- Structural
- Student Presentation
- Vehicles & Machinery
Figure 4 and Table 1 show there were too many data and they were very difficult to manage, especially when one needs various methods to view and present the data. Even though tables is one way for students to classify building interior design models, this may not work for every student. This is important, because as previously discussed, each student learns differently. A learning tool will be effective only when it has the ability to be personalized according to a student’s needs to achieve successful study. Interior design students must know how to use other media than just Microsoft Excel and Power Point.

These previous problems brought the challenge to choose another software. Filemaker Pro, with its capabilities to build a database, was selected for the taxonomy of the interior design models. Moreover, this database system gives more features that will benefit students for a more efficient, effective, and unique learning style. Figure 5 shows a frame of the data managed in Filemaker Pro.
Figure 5. A frame of data as shown in Filemaker Pro

The MALT database builds contents by a type for each model (100 records). Each model is accompanied by a symbol for each of the three main components [underlined] (quality – rough, preliminary, development, secondary, experimental, presentation; form - abstract, 2d surface, 3d mass, 3d volume, 3d combination; and subject – site, exterior, interior, product, component), paradigm steps (problem definition, staging, investigation, analysis, synthesis, implement, evaluation), physical definition, functional uses, graphic examples, and sources of authors. The basic layout is designed along with the development of contents and revised at the end of the study.

The symbols are original and uniquely created for this project. One symbol to another gradually changes without disrupting the unity of the graphic style for the entire package. Figure 6 shows the graphic symbols for quality.
The symbol of *quality* is developed from rough to presentation with graphic doodles. Each doodle represents the vision of what *rough, preliminary, development, secondary, experimental*, and *presentation* look and feel like, conceptually. They are designed from sketching unorganized lines into clear structured lines.

Symbols of *form* are developed from *abstract* to *3d combination* with numbers. Each number represents the vision of what *abstract, 2d surface, 3d mass, 3d volume*, and *3d combination* look and feel like conceptually. *Abstract* uses number one (1), graphically formed by bricks to show a feeling of abstract. The *2d surface* is graphically formed by a simple line of the true form of numerical two (2) because it is no longer abstract. The *3d mass* is graphically formed by the true form of numerical three (3) with depth added to it. It shows the feeling of a solid mass of the *3d mass* form of model. The *3d volume* is graphically formed by the true form of numerical three (3) by adding depth to it. It looks like a space in the number three form. The *3d combination* is graphically formed by the true form of numerical three (3) by adding volumetric depth to it. The bottom half is a solid space and the top half is an empty space. The *3d combination* has the combination characteristic of both *3d mass* and *3d volume*. Figure 7 depicts the symbols for type.
The symbol for subject is developed from site to component with a gradual change from the biggest scale of area concentration to the smallest scale of area concentration. Each subject name represents the vision of what site, exterior, interior, product, and component look and feel like conceptually. The site is graphically formed by framing a group of buildings. It shows the whole look of buildings side-by-side. The exterior is graphically formed by showing one particular building with no openings. The interior is graphically formed by showing one particular building with an opening to show the space inside it. The product is graphically formed by showing a piece of furniture—for example, a chair. This depicts an understanding of product expectation inside an interior. The component is graphically formed by showing a triangle as part of a product. Basically, what is shown in each of the subject from site to component is what it will look like when built from pieces of a component to create the whole look of products used in interior sand exteriors, and see them in place in the site. These graphic symbols are illustrated in Figure 8.

Figure 8. Graphic symbols for subject

Paradigm Steps is basically the stage of design processes that show the type of presentation carried into each particular stage. Problem definition takes place at the initial phase of design when programming is included. The problem of definition shows the current problems, requirements, and general goals of the projects. It has a clear understanding of the program by showing the experience necessary to deal with the problems. The problem definition can be used to show the first idea of the model. Staging is the organizing solution stage. This stage includes looking at the budget, organizing effort, time management, and
allocation. *Investigation* shows a search through the list of requirements to reach success for the project. Its satisfaction should be forced into optimum, rather than just meeting minimum requirements. This is where developing alternative design solutions can be studied. This stage will become an effective documentation or record of both a general indication along with focus design aspects and alternatives. *Analysis* shows the particular area under study in more depth, based on supporting theories that influence the construction of the model. *Synthesis* shows the concept development. This component studies detailed form or refinement of a model and is where the problem-solving solution should be satisfied. *Implement* shows construction of the interior design model, based on the construction document and can act as a presentation device. Finally, *Evaluation* shows the representation of a finished model for final evaluation of the best solution for problem-solving drawn in the model before actual construction. The model should clearly communicate to clients/audiences who see the model. All the efforts and care of the model’s builder should be represented in each of the model’s components. These stages are shown below in Figure 9.

![Paradigm Step(s)](image)

**Figure 9.** Stages leading towards model construction

Each model’s type is defined, based on the physical characteristics of its quality, form, and relevant subject. Besides this, the database also provides the functional use description of the model. This information is based on various authors found in the literature review and are given on the right side of physical definition and functional uses description. Some models are mentioned by more than one author, as shown in Figure 10. Sometimes, a few models have similar characteristics with different types. This is important to
acknowledge so students will be able to compare and contrast among these models according to the model’s characteristics. For this is the reason, the features in this database illustrate their similarities and differences.

Figure 10. The physical definitions and functional uses with their sources

Figures 11 shows the *detailed items* model. There are three records (from three different authors) that have the keyword of *detailed items* on the model type.

Figure 11. The detailed items model
MALT also provides graphic examples to show how the model type mentioned looks. Examples of pictures are shown in Figure 12.

![Example](image)

**Figure 12. Picture examples**

### B. Application of Learning Tool Design

#### B.1. Components

This Model Application Learning Tool (MALT) design will be broken down into its components. The importance of each component will be analyzed in this section.

Robert Gagne (1985) notes the concept of classifications is the building block for most of the cognitive capabilities we possess. With classification as a type of learning strategy, one can understand interrelationships of similar things together, based on a set of criteria or characteristics. In this case, the components are the interior design physical models. This classification system is important because it has been used by scientists to help them organize various information and items, and to see the relationships between them.

The classification system may include layers of organization. The examples of layer categories used in this study are quality, subject, and form. They are formal names to represent groups. Quality is the formal name that represents rough, preliminary,
development, secondary, experimental, and presentation. With a clear category division, discussions about them can have a better focus.

When one talks about an interior design physical model, what comes to mind at this time? One probably forms an image of a model displayed right in front of his/her eyes. What does the model look like? What scale is the model built? The object in one's imagination is not really specific. When one stays for a particular image in mind and discusses it further, it becomes a practice of learning for classification conceptualization. Therefore, it became narrowed down from the general idea to the model’s particular characteristics. When this model is compared and contrasted to another model, the same categories with common characteristics can be used to record and store for the model to build a clear classification in taxonomy. Another category of classification can be added outside the main category (quality, form, and subject) to provide variety. The examples provided in this study are the paradigm steps and source of authors. One thing to remember in study with classification is more categories equal more complexity for the learning process. In this way, the learning method using classification will be frustrating and confusing for students to learn at first. As they become accustomed to it method and the vocabulary, students will find it very easy to manage and use as a learning tool to enhance their learning experience for interior design.

The paradigm steps category (problem definition, staging, investigation, analysis, synthesis, implement, and evaluation) is important for the learning tool. Design paradigms can be seen as a working relationship from one component to another in the design process. More importantly, design paradigms serve as a complete pattern classified in a set of the design process. They are similar to a set of rules for producing every design output possible. Each of the design paradigms value a representation for a particular situation where a
problem occurs and demands a solution. In practice, each design paradigm should represent a 
clear application of the particular proposed design solution. All information about the design 
solution is filtered and the solution processes only those components needed for each step. 
This way, the whole design idea will not be overloaded into one step. Taking one step at a 
time for each design paradigm results in the best design output rather than skipping through 
many steps, because the evidence will not be visible to evaluate until the end of the process 
or it will lack credibility. Similar to children learning to run, they must first crawl, squat, 
stand up, walk, and finally run. There is no way that they can walk by going through one step 
only (crawl and run).

‘Physical definition’ and ‘functional use’ are important components provided in the 
learning tool model. There is a simple explanation for this. ‘Physical definition’ is important 
to help and define an understanding of the basic physical characteristics of the model. And, 
‘functional use’ is important to help define for understanding of the basic functions of the 
model. For example, as a physical definition, a pen may be defined as a solid stick with a 
textured surface on part of it and contains ink. In addition to this, as a functional use, it may 
be defined as something to write with a nonslip grip.

A source of authors is important because the researcher wants information, which is 
credible and has truthful evidence. The authors’ names provided in MALT have academic 
backgrounds and other expertise to be qualified as references for this study. This is 
important, because in the learning tool, some models’ type are mentioned by more than one 
author. Multiple authors allow students to acknowledge and to compare information 
provided, according to the authors’ statements (along with their statements for ‘physical 
definition’ and ‘functional use’).
Graphic examples are important because they show how the model type will look. A picture is worth a thousand words; they have the ability to give a new aspect to the learning tool document. This is important because graphic examples not only help introduce the visibility of a physical model type, but also help one make knowledge and discovery from the graphics. Graphic examples are become extremely useful, especially for designers, because most designers process their thinking more and better by visuals.

Finally, layout display can affect designers’ experiences of understanding the content of a subject. Because of this, one must be careful in changing a layout. A layout with a particular dimension or measurement using a grid system is important because it can change the relationship between elements. The layout page determines how these elements bind, relate, interact, and apply one to another. An example provided in the learning tool is a rectangle box that binds the context together.

B.2. Application Guidelines

This guide is intended to help designers, educators, students and other prospective users become familiar with the basic application of the Model Application Learning Tool, utilizing FileMaker Pro 9 Advanced software. This guide will introduce the features of the database, summarize its major parts and discuss a few of the most common variations in use of the system.

It is best to have this guideline near the computer when first attempting to make use of the system. Although this data-base software is very intuitive and can be learned with limited informal experience, first time users are encouraged to read the guide first and follow its examples closely as the best method of getting started. Eventually, users will find the
learning tool is easy and interesting to use. It can also provide many opportunities for creative new applications.

GENERAL CONTENTS OF LEARNING TOOL LAYOUT

The Model Application Learning Tool (MALT) record contains two pages for each model type under consideration.

First page:
1. “Title of Subject”—The default title for the system remains the same on all cards, as shown in examples. More advanced users can change the title by using FileMaker’s “layout” mode.
2. Model “Type”— A model’s type is defined based on three major physical characteristics: quality, form, and subject.

Figure 13 shows the first page of a typical record. For purposes of illustration, this booklet will focus on the “Analog” type of model.

3. Physical Characteristics— As mentioned above, in use, the database defines each type of model in terms of “Quality”, “Form”, and “Subject”. These three characteristics are defined as follows (see Figure 13):

---Quality – The degree of refinement present in the model-- rough, preliminary, development, secondary, experimental, presentation (see p.43, 68).

---Form – The general structure present in the model-- abstract, 2d surface, 3d mass, 3d volume, 3d combination (see p.43, 69).
--Subject-- The type of information presented in the model—the basic MALT focuses on sites, exteriors, interiors, products and component (see p.43, 70); users of the system may wish to add other subject categories.

In the example provided in Figure 14 the model is defined as being “Rough,” “3D Combination,” and “Product.” When checked, these labels appear in the horizontal box near the upper right corner of the record.

4. Labeling of Characteristics-- The database defines each state with both a verbal label and a unique symbol. When building a new record, clicking on the box below the symbol will record the record as being of that characteristic (i.e., quality, form, subject). Later, when searching for records (see p.56) with specific symbols, link to the summary result box, which will always appear at clicking under a symbol can be used to find models with that characteristic in the database. The summary result box is located at the top right-hand side of the main characteristics box. Each model is accompanied by a symbol for each of the three main components [underlined], as shown in Figure 13.

5. “Paradigm Stages”—The MALT makes a provision for linking each type of model to one or more steps of the design process. For this purpose, it breaks the process down into seven specific steps: 1) problem definition, 2) staging, 3) investigation, 4) analysis, 5) synthesis, 6) implement, and 7) evaluation (see p.72).

6. “Toolips” — By moving the cursor over one symbol for one of the characteristics or one of the steps of the design process, the MALT automatically provides additional explanation of that term. (Figure 14 shows an example). NOTE: The tooltips function can be turned on and off in the bottom left hand corner.
Figure 13. Page one of the record

Figure 14. Example illustrates the tooltip
Second page:

7. **Title of Subject**—Same as number 1 (see p.43).

8. **“Physical Definition”**—This provides brief description of the appearance of the model shown or for a users to describe the appearance of new models they are entering into the system (see p.45, 74).

9. **“Functional Uses”**—In much the same way as “physical definition” this provides space to describe the basic functions of models (see p.45, 75).

10. **“Sources Authors”**—This is a list of authors currently in the system; check(s) next to author(s) indicate the source(s) for some or all of the information about the model(s) being discussed. More than one author can be checked. NOTE: More advanced users can add additional authors to the checklist (see p.45, 55, 76).

11. **“Example”**—This box provides a space for showing one or more graphic examples (photo, drawing, diagram, etc.) of a particular model (see p. 78, and Figure 15 shows an example).
MODES

The Four Basic Modes

FileMaker Pro provides four different modes for use in a database. These modes and their use in this learning tool will be discussed next. They are:

A. Browse mode (see p. 46)
B. Find mode (see p. 52)
C. Layout mode (see p. 57)
D. Preview mode (see p. 65)
A. Browse Mode

In the Browse mode (Figure 16), one can view, enter, modify, and sort data.

To view the browse mode:

Click View → Browse Mode, or Click on the pencil button (Figure 17) on status area. (Note: To view the status area, click Ctrl+Alt+S)

Figure 16. The browse mode screen
Figure 17. Browse mode with pencil button area

To enter data:

Click **Records → New Record** (Figure 18), and type in a new data entry.

Figure 18. Browse mode with New Records button
To modify data:

Simply go to the field where the data needs to be modified and type in the changes. For example, one can add some lecture notes, study notes, and more of graphic examples as needed.

To sort data:

Click **Record** → **Sort**. (Note: If the data have already been sorted, the choice automatically changes to **Unsort**) (see Figure 19).

![Figure 19. Browse mode with sort/unsort features](image-url)
Because everyone learns differently, this learning tool allows the user to view data in various different layouts (Figures 120a–d).

To view those different layouts:

Click on the Layout pop-up list above the Book image on status area, or

Click on one of the easy buttons provided on the bottom right corner of the page, as shown in Figure 120a.
Figure 20b. Example of layout summary with text

Figure 20c. Example of layout subsummary
Figure 20d. Example of layout table
B. Find Mode

The Find mode allows users to search for records that contain specific data, using the current layout view feature.

To view the find mode:

Click on View → Find Mode (see Figure 21), or Click on the magnifying glass button (see Figure 22) on status area. (Note: To view the status area, click Ctrl+Alt+S)
Later after a class session, a user may want to study in preparation for an exam; focusing, for example, on everything within the category of the site model (see p. 54).
Type in “site” in the field of “model type” and click the **Find** button on the status area. The database will show all the records that have the keyword “site.” The model will also show the names of the authors who have discussed site models and include their graphic examples as shown in Figure 23.

![Design Communication through Model Making: Taxonomy of Physical Models in Interior Design Education](image)

Figure 23. Illustration to determine all records for specific type
Users can determine how many different models have been discussed by one author. To search, click on one of the checkboxes from the “sources authors,” and then click **Find** button on the status area. The database will show all the records discussed by this specific author (see Figure 24).

![Design Communication through Model Making: Taxonomy of Physical Models in Interior Design Education](image)

**Figure 24.** Illustration to determine all records for specific author
One can search for models that include particular characteristics for a specific model. To search, click on the checkboxes from the main characteristics box area. Next, click the **Find** button in the status area. The database will show all models within records that match the main characteristics chosen (see Figure 25 for example).

Figure 25. Illustration of layout to determine specific characteristics for a specific model
C. Layout Mode

The Layout mode is where one can choose the style data will appear on the computer’s screen or when printed.

To view the layout mode (Figure 26):

Click on **View ➔ Layout Mode**, or Click on the T-square button on status area (Figure 27). (Note: To view the status area, click Ctrl+Alt+S)

Figure 26. Illustration of the Layout Mode
Figure 27. Illustration of the Layout Mode with the T-square button

Ideally, one does not want to loose the layouts provided in this learning tool. So, they should normally be locked and a copy made whenever a new layout arrangement is needed (see p. 59).
To lock layout:

1. Go to the layout mode (see Figure 28).

Figure 28. Layout mode
2. Select all by typing Ctrl+A as shown in Figure 29.

Figure 29. Illustrates all data points selected
3. Select the “Arrange” tab menu on the top. The drop down menu will appear.

4. Select “Lock” as shown in Figure 30 below. Now the layout is locked (see Figure 31 on p. 62).

Figure 30. Illustrates the “Lock” feature
Figure 31. Shows layout is locked
5. Whenever the layout is locked, rearrangements or other changes in the layout cannot be made until it is unlocked. To unlock the layout (Figure 32), repeat instructions 1-3 and select “Unlock.”

Figure 32. Illustrates an unlocked layout
To copy a layout:

Click **Layout → Duplicate Layout** (see Figure 33). Now the display data are safe for rearrangement. After completion, the new layout can be accessed from the pop-up list.

Figure 33. Illustrates a Duplicate Layout
D. Preview Mode

The Preview mode is used to see the page’s layout before printing.

To view the layout mode:

Click on View ➔ Preview Mode (Figure 34), or Click on the paper button on status area. (Note: To view the status area, click Ctrl+Alt+S)

Figure 34. Illustration of the Preview Mode and paper button
To enter data:

Click **Records → New Record** (Figure 35), and type in a new data entry. Figure 36 on p. 67 shows the blank form.

Figure 35. Illustrates new record button selection
TO ADD A NEW RECORD:

To add a new card (a “Block” model, for example), the user first adds a new record (see p.66 above), types a new name for the model, and record its specifications in the database. The steps for starting a new data entry are outlined below:

1. **Give the Model a Name.** First, click on the blank space for the “Model Type.” A drop-down menu will appear. From the menu of existing model types, choose the best example, OR type in a new model type that you believe will be a useful category in the future (this category will automatically be added to your drop-down list). In this example, Figure 37 shows the new model type—“Block” (one of the existing categories).
2. **Define the Model’s Physical Characteristics.** Each new example added to the database is defined in terms of the three physical characteristics defined earlier (see p.41): quality, form, and subject. Subdivisions for each of these characteristics are outlined below:

**Quality**
- Rough—Spontaneous and unpolished development with little or no intention to achieve exactness. This characteristic is most useful in preliminary explorations. Rough quality is generally appropriate when attempting to form an initial concept or outline of a design proposal.
• Preliminary—Introductory step for connecting or leading to the main issue in the design idea proposed. Does not show many detail elements because it comes in the temporary step of design.

• Development—Intermediate step in the process of developing or in progress to advance the concept of the design idea. This applies to the organized technique in building ideas into the design’s quality.

• Secondary—Having the characteristics of a secondary degree of transformation in the quality of the design derived from the preliminary development idea. This may provide some alteration as one step forward in its development and is open for changes.

• Experimental—Relates to experience or functioning as experiment or trial to observe available options of design ideas for problem solving. This searches for findings to support particular design concepts.

• Presentation—Visual representation of final design idea/proposal. This performs in the quality for formal display view and shows a high quality of craftsmanship in the design’s product.

Form

• Abstract—Expressing design characteristics apart from the real form of particular items. This shows design ideas in a way of more extensive/general essence with reference to a design’s concept.

• 2D Surface—Physically has a flat surface or vertical and horizontal dimensions only.

• 3D Mass—Physically has a dimension of height, width, and depth. Physical appearance is solid bulk without showing any openings.
• 3D Volume—Has some degree/amount of space expressed within a three-dimensional object. Its characteristic is related to measurement or analysis by volume in its space.

• 3D Combination—Has combination characteristics of 3D-Mass and 3D-Volume.

**Subject**

• Site—A building's location.
• Exterior—Outside or external space.
• Interior—Inside or internal space.
• Product—Goods produced as the output of a design process.
• Component—A part or element, which should be connected as a set of systems or to complete the composition of a product.

Suppose the “Block” model’s main characteristics are the following:

a. **Quality:** Preliminary

b. **Form:** 3D Mass

c. **Subject:** Site

This information would be entered as shown in the example below (Figures 38a-b).

The following information would be recorded, in the following order, in the boxes for “Preliminary” (next to Quality), “3D Mass” (next to Form) and “Site” (next to Subject):
Figure 38a. Clicked on “Preliminary.”

Figure 38b. Clicked on “3D Mass” and “Site.”
3. **Defining the Model’s Paradigm Step(s).**

- **PROBLEM DEFINITION**—Defining current problems and general goals to improve condition.
- **STAGING**—Planning and organizing progression.
- **INVESTIGATION**—Finding the potential for the desired outcome.
- **ANALYSIS**—Listing specific requirements to satisfy the solution.
- **SYNTHESIS**—Combining separate elements into a coherent whole to form solutions to problems.
- **IMPLEMENT**—Fulfilling or performing plan/procedure to provide best solutions for problem-solving.
- **EVALUATION**—Determining the value of solutions to problems.

For the “Block” model, several paradigm steps are appropriate, including “Problem Definition” and “Staging.” This information is recorded by clicking on the inner part of the boxes associated with “Problem Definition” and “Staging.”
The definition of “Problem Definition” and “Staging” can be found by placing the mouse’s cursor on each word so that a tooltip, which contains its definition, will appear (see Figure 39 below).

**Figure 39. Illustrates determining a word definition**
4. **Giving the Model a Physical Definition.** A physical definition for the “Block” model can be completed by clicking the inside blank box next to the label “Physical Definition.” Type in the definition (in this case, “Block” model’s physical definition is: “Represent a whole genre of building study models that, with a purposely restricted palette, carve the external mass of an idea. Often built in a single color and material with any surface detail sacrificed to the abstraction of their pure form” (see Figure 40 below).

Figure 40. Illustration of listing a physical definition
5. **Giving the Model Functional Uses.** “Functional Uses” for the “Block” model can be completed by clicking inside the blank box next to the label “Functional Uses.” For this box, the user writes a his or her own narrative description of effective uses. For the example, this author has typed, “They can include a study of urban design implications in relation both to the immediate site-space and to that of surrounding mass. They can also act as three-dimensional bubble-diagrams that, when introduced to the site model, study contextual relationships and activity zones” (see Figure 41 below).

Figure 41. Illustration of giving the model functional uses
6. **Defining A Source’s Author(s).** When a model’s specification is defined in the literature by one or more authors, author information is added in the box to the right side of the physical definition and functional uses description. Some models are mentioned by more than one author. You can see this information by clicking on the inner part of the boxes, which belongs to the authors who provided all the information recorded (in this case, the author is “Porter, T & Neale, J”) (see Figure 42 below).

Figure 42. Illustration of defining sources authors
7. **Adding Graphic Example(s) of Models.** The database also provides a place to display graphic examples representative of how a new model type will appear (see figure 43).

To insert a picture into the graphic example box, complete the following steps:

a. Click the inside blank box for image insertion.

b. Click on the same box.

c. Select Insert Picture, and the “insert picture” window box will appear, Figure 44.

d. Select an image, and then click “Open,” Figure 45.

Figure 43. Illustration of giving the model a graphic
Figure 44. Illustration of inserting a graphic

Figure 45. Illustration of a completed graphic insertion
8. **Giving the Graphic Example a Label.** Newly inserted examples should be labeled. Click on the blank box next to those used to enter the actual graphic example(s). Type the new label (see Figure 46 below).

![Figure 46. Illustration of giving the model graphic a label](image)

---

**Design Communication through Model Making:**

**Taxonomy of Physical Models in Interior Design Education**

- **Physical Definition:** Represent a whole genre of building study models that with a generally embedded palette, save the external image of an idea. Often push in a single color and material with any added detail permitted to the distribution of their components.

- **Functional Uses:** They can include a study of urban design implications in relation both to the immediate environment and to that surrounding it. They can also be three-dimensional models that, when introduced to the site model, study contextual relationships and density processes.

---

**Sources Authors**

- Jollie, W & Heckinger, M
- Scott, W, G M
- Nash, G, G
- Pfenning, C
- Milt, O B
- Smith, A C
- Ballew, T
- Porter, T & Steele, J
- Journo, R
- Paterson, T R
- Paterson, G D

---

**Layout Options:**

- Layout Original
- Layout Summary
- Layout Subgroups
- Layout Table
CHAPTER IV. DISCUSSION

A. Overreliance on the Computer

Computers have only tended to grow more influential as time passes. They offer powerful tools (software and network) that allow people to perform professional work in the arts and sciences, games, and even instant communication (sending and receiving chats, important messages and video communication, such as Skype) via a global network. Computers have become more and more widely used in our modern society. They have never been more affordable or, in general, more accessible than now. Providing instant access to everyday tools ranging from the basic computer desktop, mp3s, mp4s, iPods, GPSs, and to cameras and smart cell phones, people have grown dependent and accustomed to using them as their primary tool (if not their only tool) for virtually everything. This is very true also for the design disciplines. With seemingly endless different types of software in the market to augment decision-making, people are tempted to place more trust in computers than in human competencies—even their own abilities.

B. Negative Consequences of Overreliance on the Computer

Despite its numerous strong contributions, overreliance on the computer can lead to equally numerous negative consequences, even disasters. For example, to design a building structural system, one needs to consider the forces of nature, proper construction, materials, and maintenances. Failure to consider each and every detail can be very costly.

For example, on January 18, 1978, a very heavy snow and ice load from a winter storm caused the collapse of the 2.4-acre roof of the Hartford Coliseum in Hartford,
Connecticut. The joint for the roof was designed, analyzed, and modeled by computer-operated design software. Unfortunately, incorrect assumptions and algorithms occurred, causing the main problem (Epstein and Smith, 1979).

People must ask whether computer software is best used in the design process as the sole means of performing tasks, in certain specific situations, or whether it should even be the primary means by which a job is performed. Even where the computer has proven to be the most effective tool for a job, experience with drawing, physical modeling, and other alternative visualization tools have often been the basis for developing initial computer proficiency.

C. Professional Benefits of Model Building

Involvement in model building may result in more sophisticated understanding of professional model performance. As is clear from an examination of the MALT, models can be employed at virtually every step of the design process. They can help people (clients and designers, alike) grasp design problems by making the program statement through a three-dimensional form. In this way, the problem and solution proposed are more visible. Through building physical models, one can also record the design progress, test, and make experiments of design decisions to understand the intended structure to be built. As many people say, “If you can’t build the model, how can they build the building?”.

Throughout time, there are many examples of model making, especially in the industrial development, for their process of production. And, the more realistic the models, the more popular they are in public. This shows that even digital models cannot replace the need for physical models.
Three-dimensional models allow spatial relations to be more clearly and directly understood. Especially for professional designers, scale models accompanied by sketches and technical drawings are very useful to enhance communication with clients and those involved in the planning and construction stages.

Physical models are used in commercial business, industry, military science, transportation, toys and ornaments. For example, most new real estate developments and other buildings are created and demonstrated by architectural with the help of interior design models throughout the process and the final proposal. Other examples include airlines and cruise ships models displayed in travel offices; universities and colleges display their mascot’s miniature; museums display historical event models; mailboxes in the miniature shape of the owner’s house; doghouse and dollhouse; etc. In fact, kings and generals, including Frederick the Great (1712-86), are said to have learned their first military lessons with the aid of toy soldiers (Payne, 1996, p.9).

D. Educational Benefits of Model Building

Model making for educational and research purposes has increased in many disciplines, including interior design education. When artist students are attempting to develop visual thinking, they learn more by making models than by only studying a picture or a computer-generated image. So, design students, who use models as self-oriented learning tools can be expected to gain a better understanding of physical subject matter than students who do not. The physical manipulation of three-dimensional assemblies that is inherent in the use of models will be one of design education’s greatest assets in inspiring, developing and honing student awareness of a better understanding of design process and
design performance, in terms of aesthetics, construction, durability, proportion, scale, sensory quality, or virtually any other educational dimension.

Admittedly, not all students will initially want to or like to build models for their projects. They may prefer producing more sketches, renderings, and construction drawings as their options in completing their projects. They might think building models is a waste of time and money. Student acceptance of modeling activity depends on a number of factors: interest, time, space, money available for modeling, etc.

However, the above resistance is often due merely to lack of exposure and encouragement. Student attitudes are likely to be closely correlated with the attitudes of their instructors. Depending on complexity, building a model can take anywhere from a few minutes to months to complete. When students know what to build and how to build their models correctly, the materials for building models do not have to be expensive. The beauty of model making is the materials used can be from whatever is easy, comfortable, and affordable for them. They even can experiment by using recycled materials or everyday materials adapted for building their models at virtually no cost. Or, one may be eager to spend money to purchase fancy materials and kits, too. Better yet, people can experiment with new materials and methods when building their models. So, the process for making models is very flexible. The appearance of a model is only one aspect in model making. The most important aspect is to show the best solution to meet the needs or purposes of the model (design problem-solving). Examples include decorative, inspiration, and communication in various fields (business, marketing, education, and research, etc.).

The inspiration for building models comes from intentional function, research, and potential materials used for planning when building the models. People usually receive
inspiration by looking at books, magazines, drawings, paintings, photographs, videos, museum exhibits, personal recollections, and especially from the works of other model makers. But, a by-product of the focus involved in some types of model building can also lead to greater interest in the subject of the model(s).

Students in the interior design discipline need to learn not only about the techniques and materials used in building digital models, but also learn about building physical models because there are no “default settings” in physical model building. Physical models require knowledge as a prerequisite for design, they cannot make design ideas or decisions, but models can act as tools to experiment with human ideas or decisions for approval. Physical models will not hide or cover errors, but they can reveal errors. To understand today’s architecture and interior designs, students must learn art history and understand the phases used to this modern era of architecture and interior design as their primary qualifications. For them to have a better understanding of building models with their own desire of technique and materials, they need to understand how models, built manually, were used in the historical era to the present. Then, students must explore artists’ works, especially on the construction part as their design process.

Scale models are designer’s creative tools and creative acts for study and approval besides technical drawings and renderings. Models built by students of architecture and interior design may be built in various scales and quality of craftsmanship (built by professional / nonprofessional) to avoid wrong assumptions or judgment of construction and to observe spatial problems, interaction of volumes, site relationship, as examples. And, it may be more useful to have options for the model to be taken apart and reassembled for a final model (including the use of color to indicate materials, ideas of movement and light
distribution). In addition, students need to know what to prepare before a model is constructed. Students need to decide and set the appropriate scale, decide how the model should be viewed, have all drawings ready that are needed for building the models, and consider the effects the model should show (including color, material, degree of detail, and realistic/abstract).
A. Summary

In the teaching and learning environments, visual, verbal, and mathematical thinking create a strong potential for the sophisticated problem-solver where art, science, technology, and communication are concerned. Educators must be able to communicate with their students effectively. Teachers’ decisions in their choice of method for teaching affects the degree of success from the messages received by their students.

Naturally, human beings always think about discovering things to make their lives easier. People create intelligent machines with no limitations. We are encouraged to have open minds about the affects of the growing technology on our lives. The changes in technologies make the way we think and act change. People think they need technology and media to think for them, as they take advantage of resources in making their lives better.

This project introduces a learning tool (MALT-- Model Application Learning Tool) in the form of an open-ended digital collection of physical models having practical value in the study and practice of interior design. This learning tool can be incorporated into various learning environments (classroom, studio, or seminar) to encourage important and mutual learning styles among educators and students. This project makes the case that something like it certainly should be.

This project is important for the interior design program, because it provides material exploration by using technology within a digital media resource to promote a flexible and adaptable learning process. Its unique form is close to a digital library for students to exploit. The digital library becomes an active facilitator for students to become active
participants/learners with unique experiences, and for creating learning communities. The taxonomy of models it proposes should help disclose the wide, often unrecognized array of model options available. It should encourage a new interest in the potential of models as design tools. Once acknowledged and embraced by students, the MALT provides a uniform tool to understand what the word “model” really means during their study. The uniformity of understanding vocabulary use in the classroom is crucial. When educators and students have a uniform understanding of the vocabulary used in the subject, the rest of the study will flow better with minimal problems.

The project creates and maintains interest in models for students. In order to achieve this aspiration, students need to acknowledge the advantages and effects of using the study material in their fields of study, especially in interior design. Students need to acknowledge the reason for the importance of learning the subject matter. This can be achieved by discovering the history of the growth of model making and related subjects before they are assigned to build a project.

Comfortable teaching and learning environments must be built in classrooms or studios. In a specific subject of learning about types of model making used in interior design education, the taxonomy model makes a perfect way to see clearly the whole branch / complete study of model making.

Various authors defined types of models in similar and different opinions. Therefore, an introduction to taxonomy of models used in interior design education is obviously needed to gain a deeper knowledge of model making. To accomplish this goal, there is a need for a learning tool to study the taxonomy. The learning tool needs to be comprehensive, easy to understand and access, and especially needs to have the flexibility for data improvement at
any time during the study. One way to build taxonomy of 3D Interior Design Models is using a database system. A database system is basically a taxonomy-based solution, useful as an information system to organizers, designers, and analysts. A database classifies and navigates contents easier and more accurately. It is possible to control the search, to broaden or narrow search categories for teaching resources into relevant information as needed.

B. Recommendation

The education of student designers can clearly be improved by using a learning tool as a product, with contents of relevant information to the subject or study material. The learning system can be more productive when the student has a personalized learning tool adapted to his or her interests. With a unique system learning tool, such as a database system for classifying and organizing text information, the end product of learning is stable, accurate, and methodical. The control system of the database can be operated efficiently in the educational environment. The learning tool should be used interactively by educators and students for the best application system in the classroom, studio, or seminar.

C. Future Study

Currently, MALT has several areas where refinements would be beneficial. Symbols used for representing each “Quality” as one of the models’ characteristics may be refined. Furthermore, it will be more useful for other people if the MALT has its own official website to share with others through networking for educational purposes.

Several other avenues for follow-up study on the subject of physical models and modeling in interior design and interior design education are also apparent. One immediate
The next step might logically be the addition of information on modeling materials and construction techniques to the existing learning tool. What materials’ characteristics contribute to accurate (or intended) interpretation of a particular model? What kind of materials and construction methods are most appropriate to each model type in terms of “authenticity,” appropriate permanence, cost, etc.? How can time spent in model construction be optimized? How can the value of any one specific model be enhanced, extended or otherwise maximized? Any and all of the above questions offer opportunities for educators and practitioners to further enhance the applied role of physical models in interior design.

The relationship between model experience and educational achievement in student performance is another area for further study. Which types of models are most successful for helping students in the learning process to work out the interior correlation of a building and to facilitate the comprehension of the three-dimensional construction, in general? Is it possible or desirable for teaching materials on model building to be standardized across universities and schools of design? Do some types of models contribute stronger learning outcomes than others? Does this depend on the category of information in question? How do educators compare the value of physical models with digital models?

D. Conclusions

In this modern era, with the growth of technology throughout the world, designers’ needs for computer and software seem inevitable. In the design process, even though particular software provides optimistic settlement, harm can still occur in many cases. To reduce destructive results of digital work, the use of digital modeling should be used as a minor function or as enhancement of representation and physical modeling in the design
process. The practice of building physical models is the closest to actual design performance in reality. Besides, models always show the passion of the builder.

To appreciate today’s architecture and interior design, students should learn art history as one of their major credentials, followed by exploring artists’ works. Moreover, this study proposes a digital collection of taxonomy of model making use in interior design education, called Model Application Learning Tool (MALT), which can be integrated into various learning environments. Its distinctive structure is similar to a digital library for students to utilize and to promote innovative learning processes and learning communities. As a result, students’ perceptions of modeling vocabulary will remain consistent for better flow of their study.

Materially and functionally, physical models are almost infinitely varied and unique. This is the reason they continue to find favor in a broad range of disciplines and practices. Although their fashionability may ebb and flow from time to time, their value never dies.
REFERENCES


*Learning and Training Innovations Magazine*. Available from


Publishing Co., Inc..


Stuttgart: Julius Hoffmann Verlag GmbH.


*Online Curriculum on the Semantic Web: The CSD-UoC Portal for Peer-to-Peer E-


Publishing Co., Ltd..


http://ltsc.ieee.org/.

L’Allier, J. (1998). Frame of Reference: NETg’s Map to the Products, Their Structure and


Bloom’s taxonomy and deeper learning principles*. Phoenix, AZ. Available from


Learning Objects: Online Version Washington DC: Agency for Instructional


GLOSSARY

As used in this work, the following definitions of terms will be adopted: The principle source for these definitions is dictionary.com. These definitions are the meanings used in this thesis.

1. Abstract: Expressing design characteristics apart from the real form of particular items.
2. Analog: Represents a mechanism relating to or put up with a similarity to something else.
3. Analysis: Listing specific requirements to satisfy the solution.
4. Animated: Has the ability to/equipped to give movement or action.
5. Architectural: Has the characteristic of architecture.
8. Building: An act of constructing objects. Or, an enclosed construction over a land or surface.
9. Classroom: A room where one learns or gains experience from learning.
10. City: A region of a state or a large town.
12. Construction: An act of constructing or arranging in a particular way.
14. Contour: Line or outline that defines an object.
15. **Component**: A part or element, which should be connected as a set of systems or to complete the composition of a product.

16. **Decorative**: Provides decoration or as a representational object or theme.

17. **Design**: Plan of ideation process or systematic process for solving a problem.

18. **Detailed**: A particular part has shown thoroughly.

19. **Development**: Revision and evaluation in production of design elements.

20. **Diagram model**: An illustration outline to summarize or demonstrate the relationship of parts as a whole.

21. **Display**: To show.

22. **Engineering**: Mechanical art or works related to machinery.

23. **Entourage**: Site foliage and other similar unique detail characteristics.

24. **Education**: Fundamental agency of nature and practice of education.

25. **Equipment**: Object provided for performing a particular purpose.

26. **Exhibition**: Presentation for view by public.

27. **Experimental**: Relates to experience or functioning as experiment or trial to observe available options of design ideas for problem solving.

28. **Exterior**: Outside or external.

29. **Evaluation**: Determining the value of solutions to problems.

30. **Façade**: Front parts of a building.

31. **Figure**: Form of a human body.

32. **Form**: The general structure present in the model.

33. **Full-sized**: Normal/actual size.

34. **Garden**: Ground where nature is nurtured.
35. Implement: Fulfilling or performing plan/procedure to provide best solutions for problem-solving.

36. Industrial: Relates to production/manufacture in industry.

37. Interior: Inside or internal.

38. Investigation: Finding the potential for the desired outcome.


40. Learning: A constructive process where the learner builds an internal representation of knowledge, a personal interpretation of knowledge developed on the basis of experience.

41. Learning tool: Represents the various steps built systematically to ensure students can meet their goals through their learning experiences.

42. Lighting: Illuminating or arranging lights to accomplish particular effects.

43. Machinery: Mechanical assembly.

44. Manual/physical: An original manmade article built by handcraft, use of boards, hand-drawings and renderings, actual handcraft 3D models, etc.

45. Map: Representation of a portion or an area of the earth.

46. Massing: Solid bulk of objects.

47. Mathematical: Related to mathematics.

48. Media: Medium for communication.

49. Miniature: Representation of something in reduced scale.

50. Model: Representational of the image of something (objects, characteristics, etc.)


52. Office-built: Construction by professional organization.
53. Paradigm stages: The stage of design processes that show the type of presentation carried into each particular stage.


55. Preliminary: Introductory step for connecting or leading to the main issue in the design idea proposed.

56. Presentation: Act of delivering visual representation of final design idea/proposal.

57. Primary: First in order.

58. Principle: A rule or method for particular application.

59. Problem definition: Defining current problems and general goals to improve condition.

60. Product: Goods produced as the output of a process.

61. Prototype: Something made and serves as the original model.

62. Qualitative: Related to quality.

63. Quality: The degree of refinement.

64. Relative: Relation to something else.

65. Reverse: The opposite.

66. Rough: Spontaneous and unpolished development with little or no intention to achieve exactness.

67. Sales: Engaged in selling.

68. Scale: A measurement device.

69. Schematic: Plan related to diagrammatic.
70. Secondary: Second rank in order, having the characteristics of a secondary degree of transformation in the quality of the design derived from the preliminary development idea.

71. Section: A part separated/cut off from the other part of an object.

72. Seminar: A group of students engaged regularly in discussions with an educator.

73. Site: A building’s location.

74. Sketch: Preliminary drawing.

75. Solid/void: Three-dimensional object without openings.

76. Space: Room in three-dimensional form.

77. Special: Having particular characteristics.

78. Staging: Planning and organizing progression.

79. Structural: Related to structure of a building construction.

80. Studio: A room or place for experimental study in arts (painting studio, ceramic studio, interior design studio, etc.)

81. Subject: The type of information presented.

82. Subjective: Individual thinking or opinions.

83. Synthesis: Combining separate elements into a coherent whole to form solutions to problems.

84. System: A set of arrangements connected to form unity or breaking down the object into components.

85. Taxonomy: A technique of classification and identification, such as a family tree.

86. Technology: Scientific application of knowledge to solve problems.

87. Three-dimensional: Physically having the dimension of depth, width, and height.
88. Topographic: Detailed mapping of an area or district.

89. Town: Urban area, smaller than a city.

90. Two-dimensional: Physically having a flat surface or the dimensions of length and width only.

91. Urban: Characteristic of a city.

92. Void: Without the content of.

93. Wind Tunnel: Tubular chamber for quality control of machinery.